
Product Guide

iQue® Antibody Internalization Reagents
 � iQue® Human Antibody Internalization Reagent
 � iQue® Mouse Antibody Internalization Reagent

Product Information

Open immediately upon arrival and store reagents at temperatures stated on labels. For research use only.

Product Name Cat. No. Format

iQue® Human Antibody Internalization Reagent

90564 1 × 96-well

90565 1 × 384-well

iQue® Mouse Antibody Internalization Reagent

90566 1 × 96-well

90567 1 × 384-well

Safety data sheet (SDS) information can be found on our website at www.sartorius.com

http://www.sartorius.com/


Introduction
Antibody internalization and associated kinetics are 
critical characteristics that impact antibody therapeutics, 
pharma cokinetic profiles, and influence the mechanism 
of action of antibody drugs. For example, antibody-drug 
conjugates may require rapid internalization to deliver 
their payload directly into cells to avoid systemic 
dissemination. However, rapid antibody internalization 
can be detrimental to immune-mediated killing 
mechanisms such as antibody-dependent cell 
cytotoxicity or complement-dependent cytotoxicity.

During biologic drug discovery, antibodies are engineered 
to increase their biological potencies, to optimize con-
jugations to non-protein components, and to increase 
serum half-life. These modifications can have profound 
effects on antibody activity and specificity, as well as 
antibody internalization. This necessitates thorough 
in vitro, high throughput screening of antibodies during 
the early discovery process to quickly identify the most 
suitable drug candidates for further development. 

iQue® Antibody Internalization Reagent is a novel, pH 
sensitive dye that identifies antibody internalization in 
a simple plate-based format. The mouse and human 
types are designed for use with antibodies containing 
either mouse or human Fc regions. The assay features 
the flexibility to combine other validated reagents for 
multiplexed, no-wash protocols with high throughput 
capabilities. The ability to quickly profile and compare 
large sets of antibodies and characterize their key 
attributes, such as antibody internalization, can vastly 
reduce the time required for candidate generation 
and expedite the development of potential 
therapeutic treatments.
 

Assay Principles

Because the reagent binds to the Fc region of the 
antibody of interest, it is essential to choose the 
appropriate type (mouse or human) of the iQue® 
Antibody Internalization Reagent.

This high-throughput, no-wash assay measures anti-
body internalization from 20 μL of sample and can 
be used to profile a large number of antibodies in a 
96- or 384-well format.

Antibodies are labeled with the novel, pH-sensitive iQue® 
Antibody Internalization Reagent. The labeled antibodies 
have little fluorescence at neutral pH, but become highly 
fluorogenic at a lower pH when they are internalized and 
processed through the acidic lysosome/endosome 
pathway. After a two hour incubation, sample acquisition is 
performed using the iQue® platform (with sampling times of 
less than 5 minutes for a 96-well and 20 minutes for a 384-
well format). The integrated iQue Forecyt® software enables 
data analysis and visualization with plate-level analytics.
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Reagents Provided

Components 1 × 96-well format  
(10 μg lyophilized powder)

1 × 384-well format 
(40 μg lyophilized powder)

iQue® Human Antibody Internalization Reagent Cat. No. 90564 Cat. No. 90565

iQue® Mouse Antibody Internalization Reagent Cat. No. 90566 Cat. No. 90567

Note: Cat. No. 90564 and 90566 (1 × 96- well format) includes 10 μg of iQue® Antibody Internalization Reagent. This is enough for 1 × 96-well 
plate of a single test antibody (at up to 4 μg/mL top concentration, 12 replicates) with overage when reconstituted. Cat. No. 90565 and 90567 
(1 × 384-well format) includes 40 μg of iQue® Antibody Internalization Reagent. This is enough reagent for 1 × 384-well plate or 4 × 96-well 
plates with overage when reconstituted

Assay Workflow Overview

Detection Channels
The iQue® Antibody Internalization Reagent uses the RL1 detection channel. This reagent was validated for use 
on the iQue® platform.

iQue® Screener PLUS Detector Channels (VBR)

Detector Spectrum Violet Laser (405 nm) Blue Laser (488 nm) Red Laser (640 nm)

445/45 nm VL1

530/30 nm VL2 BL1

572/28 nm VL3 BL2

615/24 nm VL4 BL3

675/30 nm VL5 BL4 RL1 iQue® Antibody 
Internalization Reagent 
Detection Channel

780/60 nm VL6 BL5 RL2



Assay Overview

This overview summarizes the protocol for use of iQue® Antibody Internalization Reagents. Detailed 
instructions are provided in the Protocols and Procedures section. Workflow and volumes are identical for 
both 1 × 96- and 1 × 384-well formats. For first time assay users, refer to Assay Protocol for detailed step by 
step procedures. The Assay Overview is a tool you can utilize once you are familiar with the protocol.

Count cells and resuspend at 2X desired concentration

Conjugate antibody at 2X top concentration with iQue® Antibody Internalization 
Reagent and prepare dilutions

Plate 20 µL of labeled antibody per well

Add 20 µL of cells to conjugated antibody, mix, and incubate at 37 °C for 2 hours

Acquire data on iQue® platform in the RL1 channel



Protocols and Procedures

Storage and Stability
iQue® Antibody Internalization Reagent is light sensitive; 
protect from light. 

Store lyophilized product at 2–8 °C. Rehydrate with sterile 
water and vortex gently until dissolved. Remaining 
reconstituted reagent can be stored at -80 °C for > 1 year. 
Avoid repeated freezing and thawing. Antibody labeling 
should be performed immediately before use.

Recommended Materials
We strongly recommend running a positive and negative 
istotype control along with the test antibody.

 � For the iQue® Mouse Antibody Internalization Reagent, 
the positive control is human anti-CD71 produced in 
mouse (Sigma SAB4700520-100UG, supplied at 1 mg/
mL in PBS) and the negative isotype control is Mouse 
IgG1 (R&D Systems, MAB002).

 � For the iQue® Human Antibody Internalization Reagent, 
the negative isotype control is Human IgG1 (Absolute 
Antibody, AB00178-10.0).

Materials Required but Not Provided
 � Test antibody of interest (with human or mouse 

Fc region) at a known concentration
 � Target cells of interest
 � Target cell growth media
 � Multichannel pipette capable of delivering 20 µL 

(e.g. Sartorius Tacta or Picus)
 � 96-well v-bottom plate (iQue® #10149) or 384-well 

v-bottom plate (Greiner #781280)

Cell Preparation
Count target cells and adjust concentration with growth 
media to 2X desired final assay concentration in a volume 
sufficient to ensure 20 µL per well with overage. We suggest 
a final assay concentration of 1 × 106 cells/mL.

For a 96-well format, we recommend at least 3 mL of cells 
prepared at 2 × 106 cells/mL (6 million cells) to 
accommodate liquid handling. 

For a 384-well format, we recommend at least 12 mL of  
cells prepared at 2 × 106 cells/mL (24 million cells) to 
accommodate liquid handling.

Calculation for 2 Replicates: Mouse Antibody Labeling 
Using Positive Control Anti-CD71 at 1 mg/mL Stock 
Concentration for 1 × 96- Well Format 

1. Determine final assay concentration of test antibody. 
1 μg/mL for anti-CD71 is recommended for a positive 
control. Prepare working stock at 2X or 2 μg/mL. 

2. Determine volume of test antibody required at 2X for 
2 replicates of 20 μL per well top concentration as 
well as adequate overage for 1:2 serial dilutions: 

 ( # of wells) × (volume per well) × (overage 
for serial dilutions) 

 2 wells × 20 μL per well 5 = 200 μL labeled 
antibody at 2X

3. Calculate volumes of test antibody, iQue® Antibody 
Internalization Reagent, and media for a 2X final 
assay concentration of labeled antibody: 
a. Determine volume of test antibody. For a small 

number of replicates, dilute test antibody stock to 
100 μg/mL for more accurate pipetting: 

 (total volume of labeled antibody) μL × (2X 
final concentration of test antibody) μg/
mL/(diluted stock concentration of test 
antibody) μg/mL 

 (200 μL) × (2 μg/mL)/(100 μg/mL) = 4 μL 
of test antibody (at 100 μg/mL) 

b. Determine volume of iQue® Antibody 
Internalization Reagent: 

 (volume of test antibody) μL × (diluted 
stock concentration of test antibody) μg/
mL/ (stock concentration of iQue® 
Antibody Internalization Reagent) μg/mL 

 (4 μL) × (100 μg/mL)/(100 μg/mL) = 4 μL 
iQue® Antibody Internalization Reagent 

c. Determine volume of media: 
 (total labeled antibody volume) – (test 

antibody volume) – (iQue® Antibody 
Internalization Reagent volume) 

 (200 μL) – (4 μL) – (4 μL) = 192 μL media 

Preparation of Reagent for 1 × 96- and 1 × 384-Well Format
1. Rehydrate iQue® Antibody Internalization 

Reagent with 100 μL sterile water for 1 × 96-well 
format (or 400 μL sterile water for 1 × 384-well 
format). This results in a final concentration 100 
μg/mL for either format. The reagent is light 
sensitive; protect from light.

  Prepare a 1:3 molar ratio of test antibody to iQue® Antibody 
Internalization Reagent. The reagent is approximately one third 
the size of an antibody, equal mg/mL quantities will produce a 
1:3 molar ratio of test antibody to reagent.

2. Calculate the amount of labeled antibody needed 
using the following formula:
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Assay Protocol for for 1 × 96- and 1 × 384-Well Format
Label test antibody and prepare dilutions. We strongly 
recommend running an appropriate positive and negative 
istotype control along with the test antibody for the mouse 
or human type.

1. Add test antibody and iQue® Antibody Internalization 
Reagent (using previous calculations) to culture media 
in a tube. Protect from light, and incubate for 15 minutes 
at 37 ˚C.

2. Prepare 1:2 serial dilutions of the labeled antibody in 
culture media. This can be done in a separate 96-well 
format or in tubes.

3. Plate 20 µL of dilutions (including a media-only blank) 
in a 96- or 384-well plate from low to high 
concentration. The template includes positive and 
negative controls run in duplicate.

4. Add target cells to plated, labeled antibody dilutions. 
Depending on the number of samples and replicates, 
you may choose to plate either horizontally or vertically.

a. Use a multichannel pipette to add 20 µL of well-mixed 
target cells at 2X to the wells of a 96- or 384-well format.

b. Mix using either the plate shake function on the iQue® 
platform (2000 RPM) or manually with a multi channel 
pipette. For plate Shaker instructions see Appendix A.

5. Cover plate and incubate at 37 ˚C for 2 hours.
6. Acquire data on the iQue® platform.
  Note: The work flow and volumes are identical for 1 x 96- and 

1 x 384-well formats.

System Operation
1. Launch iQue Forecyt® software.
2. If you have not already imported the template provided 

by iQue®, import it now, and select the correct format 
(96- or 384-well). Create a New Experiment using the 
template. 
File→New Experiment→Use Template→Experiment 
Name

3. If you have samples other than the recommended 
controls on your plate, you can set up Series dilutions in 
the Series tab. You can also change the concentrations 
or layout of Series at this time. 
Design→Series→Add Series

4. Be sure your plate is in place and click “Run” on the 
Menu to acquire data.

Data Analysis
1. Identify cell populations: the template gates are pre-

set for different populations (cells, single cells, and 
internalized cells). Below are the gating details if you 
want to manually draw the gates or fine tune the 
existing gates from the template:
a. In all events, FSC-H vs. SSC-H, draw gate around 

“cells” avoiding cell debris.
b. Make a new plot, FSC-H vs. FSC-A, gating on “cells,” 

and draw another gate around “single cells.”
c. Make a histogram based on “single cells,” change the 

x-axis to “RL1-H,” and draw a gate for “internalized 
cells” which will appear furthest to the right.



All Events

Cells

Single Cells

Examples of Positive and Negative Control Antibody 
Dose Response Curves Showing MFI and Percent 
Internalized for Jurkat Cells:

2. Plot dose response curves: the template includes a 
dose response curve plotted for Mean Fluorescent 
Intensity (MFI) and percent internalized for a control 
sample. Follow these steps to create curves for 
additional samples:
a. Create Primary Metric 

Metrics→Add→Primary Metric 
(Primary Metrics for “median RL1-H of internalized 
cells” and for each antibody and/or cell type tested)

b. Create Advanced Metric 
Metrics→Add→Advanced Metric 
(“Internalized cells as percent of single cells” and for 
each antibody and/or cell type tested)
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North America
Sartorius Corporation
300 West Morgan Road
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USA
Phone +1 734 769 1600
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Epsom 
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Sartorius Japan K.K. 
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Japan
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Appendix A

Mixing Samples Using Shaker
This assay requires shaking. If you don’t have a separate 
shaker, you can use the one on the iQue® platform.
1. Click on Device in the menu bar.
2. Scroll down to Manual Control.

3. In the Manual Control window, use the arrows 
to set the RPM.

4. As soon as you click On, the shaker will begin to 
shake and continue to shake until you unclick.
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